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RESUMO  
As inundações nas bacias hidrográficas acarretam prejuízos para a população, sendo estes eventos 
agravados em função de vários fatores. A escassez de informações, como mapas de risco, que 
possam auxiliar a gestão em áreas susceptíveis, tem sido um grande problema. Nesta perspectiva o 
presente trabalho tem por objectivo mapear áreas susceptíveis ao risco de inundações na Bacia do 
Púnguè, com base em técnicas de geoprocessamento e método AHP. As principais variáveis 
utilizadas foram: declividade, altimetria, uso da Terra. Com base em técnicas de geoprocessamento e 
métodos AHP foram atribuídos pesos para classificar a influência destes fatores na ocorrência de 
inundações, e pela sobreposição destes fatores, retornou o mapa de susceptibilidade, com valores 
identificando as áreas com o de baixo, médio e alto risco. Os principais resultados demonstram que 
em 41% da área de estudo prevalece a classe alto risco de inundação, seguida pelas classes médio 
risco (34%) e baixo risco (25%), representadas em tons de azul, amarelo e vermelho, 
respectivamente.  
 
PALAVRAS-CHAVE: AHP. Inundações. Risco. Geoprocessamento. Mapeamento. 
 
 
ABSTRACT 
Floods in river basins cause damage to the population, and these events are aggravated by several 
factors. The scarcity of information, such as risk maps, that can assist management in susceptible 
areas, has been a major problem. From this perspective, the present work aims to map areas 
susceptible to the risk of flooding in the Púnguè Basin, based on geoprocessing techniques and the 
AHP method. The main variables used were slope, elevation, land use. Based on geoprocessing 
techniques and AHP methods, weights were assigned to classify the influence of these factors on the 
occurrence of floods, and by overlapping these factors, the susceptibility map was returned, with 
values identifying areas with low, medium and high risk. The main results demonstrate that in 41% of
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the study area the high flood risk class prevails, followed by the medium risk (34%) and low risk (25%) 
classes, represented in shades of blue, yellow and red, respectively.  
 
KEYWORDS: AHP. Floods. Risk. Geoprocessing. Mapping. 
 
 
RESUMEN 
Las inundaciones en las cuencas hidrográficas causan daños a la población, y estos eventos se 
agravan debido a varios factores. La escasez de información, como mapas de riesgos, que puedan 
ayudar a la gestión en zonas susceptibles, ha sido un problema importante. En esta perspectiva, el 
presente trabajo tiene como objetivo mapear áreas susceptibles de riesgo de inundación en la 
Cuenca del Púnguè, a partir de técnicas de geoprocesamiento y el método AHP. Las principales 
variables utilizadas fueron: pendiente, altimetría, uso del suelo. Con base en técnicas de 
geoprocesamiento y métodos AHP, se asignaron pesos para clasificar la influencia de estos factores 
en la ocurrencia de inundaciones, y mediante la superposición de estos factores, se devolvió el mapa 
de susceptibilidad, con valores identificando las áreas con riesgo bajo, medio y alto. Los principales 
resultados muestran que en el 41% del área de estudio prevalece la clase de alto riesgo de 
inundación, seguida de las clases de riesgo medio (34%) y riesgo bajo (25%), representadas en 
tonos de azul, amarillo y rojo, respectivamente. 
 
PALABRAS CLAVE: AHP. Inundación. Riesgo. Geoprocesamiento. Cartografía. 
 

 

1. INTRODUÇÃO  
 
As mudanças climáticas constituem um dos mais complexos desafios do século XXI. Os 

impactos verificam-se no aumento da frequência dos desastres naturais. Moçambique ocupa a   10ª 

posição dos países mais vulneráveis a este tipo de fenómenos. Nos últimos 30 anos, pelo menos 

14% da população foi afetada por secas ou cheias. Esta situação tem causado perdas humanas 

significativas, o que se reflete na necessidade de implementação de ações de gestão do risco de 

inundações. 

As inundações são o fenómeno que mais danos causa ao meio ambiente e à economia de 

um país. Destacam-se aqui perdas de vidas humanas e impactos económicos muito significativos. As 

perdas económicas causadas por desastres como inundações, terremotos, tsunamis e ciclones 

aumentaram hoje para uma média entre 250.000 milhões e 300.000 milhões de dólares por ano. 

(Gar, 2015)  

Moçambique é um país altamente vulnerável aos eventos extremos. Por outro lado, estes 

desastres têm a tendência a aumentar, não só pelo número como também pela magnitude. O que 

resulta em perdas de vidas humanas, económicas e financeiras, assim como danos ambientais 

graves. Os países com baixo rendimento são os que mais sofrem com os eventos climáticos 

extremos. Se nada for feito a este nível, é muito provável que nos próximos tempos os desafios 

sejam cada vez maiores. Portanto, são necessárias medidas a curto e médio prazo para mitigar os 

impactos desses eventos, de modo a não comprometer os Objectivos de Desenvolvimento 

Sustentável (OSD). Onde o estudo pode ser enquadrado nos Objetivos 12 e 15 (Agenda 2030 da 

ONU), garantir padrões sustentáveis de consumo e produção, e proteger, restaurar e promover o uso 

sustentável dos ecossistemas terrestres, gerir de forma sustentável as florestas, combater à 
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desertificação e deter e reverter a degradação da terra e deter a perda de biodiversidade, 

respectivamente. 

Gonzalez et al., (2016) definem vulnerabilidade como o grau de perda para um dado 

elemento, ou comunidade dentro de uma determinada área passível de ser afetada por um fenômeno 

ou processo. Entretanto, como forma de reduzir o nível de vulnerabilidade das populações, a inclusão 

da participação das comunidades vulneráveis ao risco de inundações no processo de tomada de 

decisão é apontada como um fator importante. Isto é, pode contribuir para o melhoramento do 

processo de planeamento criando oportunidade para a combinação de informação proveniente dos 

diferentes intervenientes (Vasconcelos et al., 2006). 

O mapeamento das áreas de risco a inundações tem extrema importância no planejamento 

territorial, pois é uma ferramenta que subsidia a prevenção e controle de desastres naturais 

decorrentes da expansão urbana, que está diretamente associada ao grau de risco e prejuízos 

causados por estes eventos. Os mapeamentos, em geral, produzem cartas de suscetibilidade, perigo 

ou risco e têm correspondência com os objetivos do mapa e com as escalas de trabalho envolvidas.  

Diante do exposto, esse estudo objetivou elaborar o mapeamento de áreas de risco de inundações 

na Bacia Hidrográfica de Púnguè por meio do componente biofísico, através do Método de Análise 

Hierárquica (AHP) para o uso e aproveitamento sustentável. 

 
2. METODOLOGIA 

2.1. Descrição da área de estudo 

 
Bacia Púnguè- ocupa uma área total de cerca de 29 500km, sendo 28 000km no território 

moçambicano, o rio Púnguè nasce no Zimbabué e percorre uma extensão de cerca de 322km na 

planície desaguando no oceano índico. 

            Com uma área total de aproximadamente 29.500 km², a bacia do Púnguè é uma das maiores 

de Moçambique. O rio Púnguè, com seus 322 km, nasce no Zimbabwe e desempenha um papel 

crucial no ecossistema e na economia da região. Com uma área total de aproximadamente 29.500 

km², a bacia do Púnguè é uma das maiores de Moçambique. O rio Púnguè, com seus 322 km, nasce 

no Zimbabwe e desempenha um papel crucial no ecossistema e na economia da região, como ilustra 

a figura 1. 
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Figura 1: Localização geográfica da Bacia Hidrografica do Rio Pungue 

 

Fonte: Autores, 2024 

 
A bacia hidrográfica do rio Púnguè é caracterizada por uma diversidade de actividades 

humanas, que inclui agricultura e mineração, exige um conhecimento mais aprofundado da 

fragilidade ambiental da região para garantir a sustentabilidade dos recursos naturais. Entretanto, 

nota-se ausência de conhecimentos sistematizados sobre a fragilidade ambiental face às 

particularidades da Geodiversidade e da biodiversidade, que podiam servir de base para definição de 

medidas de prevenção ou de correção de riscos ou impactos ambientais associados. 

 
2.2. Materiais e métodos 

Mapa de risco de inundação 

 
O método de Análise Hierárquica (AHP) é uma ferramenta para tomada de decisões que 

organiza informações em uma estrutura hierárquica. Através de comparações par a par, o decisor 

atribui valores de importância relativa aos diferentes critérios, permitindo estabelecer uma hierarquia 

e priorizar as alternativas (Berger et al., 2007). A altitude, declive, uso e aproveitamento da terra e o 

tipo de solos são factores extremamente fundamentais e conjugados que influenciam o nível da água 

determinado por uma enchente (Santos, 2010). 
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a) Altitude 

 
A altitude é um factor determinante no risco de inundação. Em uma bacia hidrográfica, a água 

tende a escoar das áreas mais altas para as mais baixas devido à força da gravidade. Assim, regiões 

com maior altitude estão menos sujeitas a inundações, enquanto áreas mais baixas concentram o 

volume de água, aumentando o risco de alagamentos (Magalhães et al., 2011, p. 65). 

 
b) Declividade 
 
A declividade do terreno exerce um papel fundamental na ocorrência de inundações. Em 

áreas com baixa declividade, a água proveniente das chuvas escoa lentamente, acumulando-se nas 

depressões do terreno e aumentando o risco de inundaçooes e vice-versa. (Magalhães et al., 2011, 

p. 65). 

c) Uso da Terra 
 
O uso e a ocupação do solo influenciam diretamente o escoamento superficial. Áreas 

impermeabilizadas, tendem a acumular mais água, aumentando o risco de inundações, em 

comparação com áreas com cobertura vegetal (Magalhães et al., 2011, p. 65). 

 
Matrizes de decisão 
 

Para elaboração da matriz utilizou-se a escala fundamental de Saaty, conforme apresentado 

no Quadro 1. A elaboração é definida a partir de uma escala linearmente hierárquica de importância 

entre os fatores de estudo. 

 
Tabela 1: Escala de comparadores 

Valores Nível de Importância 

1/9 Extremamente menos importante que 

1/7 Muito fortemente menos importante que 

1/5 Fortemente menos importante que 

1/3 Moderadamente menos importante que 

1 Igualmente importante a 

3 Moderadamente menos importante que 

5 Fortemente mais importante que 

7 Muito fortemente mais importante que 

9 Extremamente mais importante que 

Fonte: Saaty (1997), citado por Rosot et al. (2000) 

 
Santos et al. (2010) afirmam que a fase de atribuição dos valores, com base na escala de 

comparadores, é considerada um dos momentos mais importantes durante o processo de confecção 

dos mapas de inundação, já que os valores de importância atribuídos a um fator interferiram 

diretamente no resultado obtido. A matriz de comparação pareada desenvolvida é apresentada 

conforme a Tabela 1. Portanto o fator altitude foi definido como mais importante diante dos outros 

três fatores e em seguida foi a declividade. 



 
  

                      RECIMA21 - REVISTA CIENTÍFICA MULTIDISCIPLINAR 
                     ISSN 2675-6218 

 
MAPEAMENTO DE ÁREAS SUSCEPTÍVEIS A RISCO DE INUNDAÇÃO NA BACIA HIDROGRÁFICA DO PÚNGUÈ, MOCAMBIQUE 

Gerson Moura Chitula, Adalberto Paulino Falso Armindo, Nhelete Cherinda, Lelia Yasmin Roberto Ussene 
 

RECIMA21 - Ciências Exatas e da Terra, Sociais, da Saúde, Humanas e Engenharia/Tecnologia  

 

v.5, n.9, 2024 
  

6 

Tabela 2: Matriz de comparação dos fatores 

Fatores Declividade Altitude Uso e ocupação 

do solo 

Tipos de solos 

Declividade 1 1 2 5 

Altitude 1 1 2 9 

Uso e ocupação do 

solo 0,5 0,5 1 3 

Fonte: Matriz AHP, adaptado pelo autor, 2024 

 
Para essa etapa foram realizadas operações aritméticas utilizando a ferramenta raster 

calculator do software ArcGIS, onde foram associados os parâmetros de suscetibilidade a inundação 

reclassificados e representados por dados matriciais com os pesos estabelecidos na etapa anterior. 

Após a obtenção dos pesos de cada fator, atribui-se de seguida os valores conforme a Equação 1, 

para elaboração do mapa de área de risco inundação. 

R = 48D + 42A + 10US (Eq. 1) 

Em que: 

• R: Risco de Inundação no Distrito de Dondo; 

• D: Mapa de declividade (%); 

• A: Mapa de Altitude (m) 

• US: Mapa de uso e ocupação de Solo. 

 
Elaboração dos mapas dos fatores analisados 
 

Para elaboração dos mapas dos fatores analisados, foram posteriormente reclassificados em 

classes, as quais foram aplicadas notas de acordo com o seu grau de susceptibilidade à inundação 

variando de 0 a 10, do menos ao mais susceptível. 

 
Altitude (m) 
 

Adquiriu-se um SRTM no site da USGS1, com a resolução espacial de 30m e de seguida foi 

feito a sua correcção (fill) para preencher os vazios. Seguiu-se a selecção do contorno geral da área 

de estudo, o seu Shapefile (shp), onde foi sobreposta ao modelo digital de elevação (MDE) e feito o 

processo de extracção da mascara "Extract by Mask" para se ter apenas o recorte do MDE da área 

de estudo, e de seguida foi seleccionado o seu datum original WGS_84 Zona 36S. Posteriormente 

extraiu-se as curvas de níveis automaticamente no ArcGIS 10.8, com a equidistância de 30m 

registadas automaticamente na tabela de atributos, com a finalidade de criar a base planialtimétrica, 

possibilitando à geração de redes de triângulos irregulares (TIN) para dar lugar à elaboração do 

modelo digital de elevação (MDE), com a ferramenta: "Contour", que se localiza em Spatial Analyst 

Tools → Surface. Para a elaboração do TIN foi utilizada uma base de dados de curvas de níveis no 

formato Shapefiles (shp) obtidas automaticamente, como anteriormente referenciada. Este formato 

 
1 United States Geological Survey: https://earthexplorer.usgs.gov/  

https://earthexplorer.usgs.gov/
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permitiu o cruzamento de informações referente à hipsometria e geomorfologia do terreno na 

ferramenta Arc Toolbox → 3D Analyst Tool → TIN Management → Creat TIN no software ArcGIS 

10.5. Gerado o TIN, seguiu-se o processo de criação do MDE o qual foi convertido do formato raster 

para Shapefiles obedecendo aos passos de sua transformação a partir da ferramenta ArcToolbox → 

Spatial Analyst Tool → Reclass → Reclassify → Convertion Tool → From Raster → Raster to 

Polygon em ambiente ArcMap 10.8, finalmente foi reclassificado em 5 classes e as notas aplicadas 

conforme o Quadro 2 abaixo. 

 
Tabela 3: Peso atribuídos ao MDE 

Classes de Altitude (m) Notas 

- 8 - 223 10 

223 - 477 7 

477 - 783 5 

783 - 1279 2 

1279 - 2584 1 

 
Declividade 
 

A partir do layer do limite da área recortada do local da pesquisa e, diante dos dados já 

extraídos automaticamente para a tabela de atributos  gerou-se o TIN e MDE que transformados em 

Raster já criados, permitiu a geração do mapa de declividade da área de estudo através da 

ferramenta Arc ToolBox → 3D Analyst Tools → Spatial Analyst → Tools → Surfce → Slope no 

ambiente ArcGis 10.8. O MDE foi posteriormente reclassificado em cinco (5) classes e as notas foram 

aplicadas de acordo com o Quadro 4. 

 
Tabela 4: Peso atribuídos a Declividade 

Declividade (%) Classes de Relevo Notas 

0 – 3 Plano 10 

3 – 8 Suave Ondulado 9 

8 – 20 Ondulado 7 

20 – 45 Fortemente Ondulado 3 

                    >45 Montanhoso 1 

 
 
Uso e ocupação da terra 
 

Para a identificação de classes de uso e ocupação do solo da Bacia do Púnguè, foi mediante 

a utilização da base de dados pré-existente, fornecida pelo CENACARTA (Centro Nacional de 

Cartografia e Teledetecção), posteriormente reclassificada e atribuída os seguintes pesos, conforme 

ilustra o Quadro 5 abaixo: 
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Tabela 5: Peso atribuídos a classe de uso e ocupação de solo 

Classes de uso e ocupação de Solo Notas 

Arbustos 1 

Vegetação 1 2 

Área de Cultivo 5 

Urbanização 8 

Água 10 

Vegetação 2 3 

Após a execução do cálculo algébrico do Risco, que posteriormente foi convertida para 

polígono para possibilitar o cálculo e delimitação da área de alto risco de inundação. 

 
3. ANÁLISE E DISCUSSÃO DE RESULTADOS 

 
Por meio da utilização do SIG, foi possível compor os mapas de comportamento dos 

parâmetros de risco à inundação elencados neste estudo, como apresenta a Figura 2. São eles: 

altitude (A), declividade (B), uso da terra (C). 

Conforme contabilizado, as 3 classes de maior presença no mapa da bacia hidrográfica do rio 

Pungue, segundo ordem de importância foram: a classe baixa, média e alta. Diante disso, a classe 

Alta  representa zonas de maior susceptibilidade a inundações ao longo da bacia, e são 

representadas no mapa pela cor azul, na qual constituem áreas de maior risco de inundações a nível 

da bacia. Deste modo, a classe Alta foi identificada como o nível de susceptibilidade com maior 

proximidade dos canais de acumulação de massas de águas no rio.  

A classe média e baixa, são caracterizadas pela presença de áreas de menor risco de 

inundações na bacia. Assim sendo, na classe média que no mapa, representa a cor amarelada, é 

possível observar que existem áreas de pequenas proporções que são caracterizadas por médias 

inundações, ou seja, na classe media, existem áreas na qual podem ocorrer inundações, mais de 

pequenas proporções pois essas são áreas são caracterizadas por relevo ondulado. 

A última classe, que no mapa representa a cor vermelha, é caracterizada pela Baixa, ou seja, 

pela ausência de risco de inundações na bacia hidrográfica do rio Pungue. Diante disso, vale 

ressaltar que, a classe baixa, corresponde áreas montanhosas ao longo do rio Pungue. 
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Figura 1: Mapa de risco de inundação da bacia do Púnguè, 2024 
Fontes: Autores 

 
O mapa demonstra que em 41% da área de estudo prevalece a classe alto risco de 

inundação, seguida pelas classes médio risco (34%) e baixo risco (25%), representadas em tons de 

azul, amarelo e vermelho, respectivamente.  

Percebe-se que as áreas consideradas como de risco muito alto estão concentradas 

principalmente nas regiões mais baixas da bacia (altitude menor que 250 m) e com declividades 

menores, inferiores a 23 %. Observa-se, ainda, que essa classe está localizada prioritariamente à 

margem direita. Nessas áreas concentram-se poucas edificações, as quais impedem que ocorra 

infiltração de água de chuva no solo. Apesar dessas áreas estarem localizadas majoritariamente em 

solos considerados bem drenados, percebe-se que à baixa declividade, intensificam o grau de risco a 

inundação, uma vez que a água tende a escoar e acumular-se nestas regiões com maior intensidade 

por falta de áreas permeáveis. 
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As áreas que apresentam risco altíssimo e alto de inundação estão, em sua maioria, sobre as 

áreas de relevo plano a suave ondulado. A menor declividade confere às áreas diminuição da 

capacidade de escoamento da água por consequência do maior tempo de retenção e acúmulo. 

Segundo Oliveira et al., (2010), Kang et al., (2013), Rudari et al., (2014) e Oliveira et al., (2004), 

quanto maior a altitude e declividade, menos suscetível é a área à ocorrência de inundações. Este 

fato esta associado ao tipo de relevo, pois apresenta um relevo plano, onde a massa hídrica tem 

maior concentração, e também em épocas chuvosas, facilitando o processo de inundações ao longo 

da bacia hidrográfica do rio Pungue. 

A classe de risco médio se concentra em espaços com declividades entre 3 e 20%, altitude 

acima de 780 metros e com variação do tipo de solo. Contudo, o que se percebe é que a existência 

de área não edificada contribui para permeabilidade nesses locais, diminuindo assim a 

susceptibilidade à ocorrência de inundação.  

A classe de baixo risco situa-se em áreas com declividades acima de 20% em diante, altitude 

acima de 1200 m, espaços não edificados e com cobertura vegetal. Por apresentarem baixo índice 

de permeabilidade e relevo montanhosos, nessas áreas a possibilidade de haver inundação é 

totalmente inexistente. Entretanto, tais áreas podem se tornar geradoras potenciais de fluxo 

superficial. 

Ao relacionar as informações do mapa de uso do solo com as do mapa de risco de 

inundação, ficou claro que o percentual de risco de inundação é mais alto nas áreas impermeáveis 

devido à presença de solos jovens, associados com a ocupação urbana. Assim, áreas impermeáveis 

contribuem também para o “aumento da velocidade e do volume de escoamento superficial das 

águas urbanas; aumento do número e da frequência das inundações; incremento da poluição difusa 

pela lavagem das superfícies urbanizadas (...)” (Vargas, 1999 apud Andrade 2011, p. 13). Sabendo 

desses impactos causados pela existência de áreas impermeáveis nas cidades, é necessário que os 

órgãos públicos criem estratégias e normas reguladoras para atenuar e compensar a 

impermeabilização dos solos. 

 
4. CONCLUSÕES E RECOMENDAÇÕES 

 
Os estudos que buscam a qualificação ou quantificação da fragilidade ambiental de uma 

determinada área são de extrema relevância para o planejamento e gestão territorial. A partir deste 

estudo foi possível identificar e analisar as áreas mais susceptíveis à ocorrência de inundação no 

perímetro. Para isso, aplicou-se a reclassificação de variáveis e o método de processo analítico 

hierárquico (AHP). O uso de geotecnologias contribuiu de forma expressiva para as análises de risco 

à inundação, pois seus resultados auxiliarão os gestores na tomada de decisões de caráter mitigador, 

quando já tenha ocorrido a ocupação dos espaços inadequados, e preventivo, visando a qualidade 

socioambiental nas cidades. Deste modo, estudos com objetivos e metodologias semelhantes como 

o desta pesquisa devem ser aplicados, modelados e financiados, pois são de extrema importância 
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para o gerenciamento ambiental de áreas que estão cada vez mais expostas às atividades 

antrópicas. 
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